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This document is provided to machine manufacturers . It suggests the processes that manufacturers can implement in order to customize these 
systems. 

It is recommended that all operations be performed by properly trained engineers. The engineers should read and understand the information
given in this document and be authorized by the machine manufacturer.

In accordance with its policy of continuous improvement, Poclain Hydraulics reserves the right to modify the specifications of all products 
described herein without prior notice.

The illustrations are not contractual. 
 ©Poclain Hydraulics Industrie 2006.

This document is the property of Poclain Hydraulics Industrie
This document is the property of Poclain Hydraulics Industrie. It is strictly confidential. It must not be used, duplicated, copied or disclosed to a 
third party in full or in part without our prior written consent.
The trademark Poclain Hydraulics is the property of Poclain Hydraulics S.A.
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FOREWORD
Introduction
Poclain Hydraulics has created and developed SmartDrive Canalogger, a system that allows collecting various data like frequencies,
temperatures, pressures, etc.

It has been designed to resist to hard environments such as agriculture and forestry, construction, etc.

It includes a Canalogger that collects various signals such as temperature, speed and pressure through sensors.

The Canalogger Explorer software is used to set up the Canalogger.
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Canalogger general characteristics 

Overall dimensions

Conformity:  according to the standards:

• EN 61000-6-2 Edition 2001
• EN 55022 Edition 1998 / A2 Edition 1998
• ISO 14982 Edition 1998
• EN 13309 Edition 2000
• EN 12895 Edition 2000

Mechanical resistance :

• Vibrations : 0.05 g²/Hz from 10 to 200 Hz then -3 dB / octave until 500 Hz according IEC 68-2-64 
• Shocks : 50 g during 11 ms according IEC 68-2-27

These standards are the relevant standards for the intended purpose of the product: data acquisition on construction machinery, agricultural 
and forestry machines and industrial trucks.

Description Characteristics
Model code  Canalogger

Inputs

• 12 analog inputs
• 8 temperature inputs
• 8 digital inputs
• 5 frequency inputs
• 1 supply input (power)
• 1CAN/COM plug
• 1 DIAG plug

Supply voltage 10 to 30 V

Operating temperature - 20°C to 70°C
[- 68°F to 158°F]

Overall dimensions See below
Material Polycarbonate

Mass 3.85 kg
[8.47 lb]

 Canalogger protection index with its connectors IP 65

Canalogger set-up Set-up with a PC using the Canalogger Explorer software application 
and the serial link or using the hand held terminal

Sample frequency
• Up to 350 Hz for analog, frequency and digital inputs
• Up to 25 Hz for temperature inputs
• Up to 1 Mbit/sec for the CAN bus

Saving 64 MB Compact Flash Card inserted in a Compact Flash/PCMCIA 
adapter (supplied)

Communication Serial link RS 232
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Canalogger front panel
The Canalogger front panel displays a trap door that protects the memory card and 4 leds.

Memory card

The Canalogger data are saved on a Compact Flash Memory card.

Description of the leds

Place your thumbs under the trap door and push up to open. 

Leds Function
Green On / Off
Blue Record

Orange • Permanent: storage capacity < 10%
• Flashing: storage capacity = 0%

Red Flashing: error
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SmartDrive Canalogger input / output characteristics

Description Inputs Description Inputs
Frequency inputs FREQ 1 Temperature inputs TEMP 1

FREQ 2 TEMP 2
FREQ 3 TEMP 3
FREQ 4 TEMP 4
FREQ 5 TEMP 5

Digital inputs DIG 1 TEMP 6
DIG 2 TEMP 7
DIG 3 TEMP 8
DIG 4 Supply (Power) -
DIG 5 CAN/COMplug -
DIG 6 DIAG plug -
DIG 7
DIG 8

Analog inputs ANA 1
ANA 2
ANA 3
ANA 4
ANA 5
ANA 6
ANA 7
ANA 8
ANA 9
ANA 10
ANA 11
ANA 12

ANA 1 ANA 2 ANA 3 ANA 4

ANA 7 ANA 8 ANA 9 ANA 10

DIG 1 DIG 2 TEMP 1 TEMP 2

DIG 3 DIG 4 TEMP 5 TEMP 6

DIG 6DIG 5

DIG 7 DIG 8 FREQ 5
POWER CAN DIAG

FREQ 1 FREQ 2 FREQ 3 FREQ 4

TEMP 7 TEMP 8

TEMP 3 TEMP 4

ANA 11 ANA 12

ANA 5 ANA 6
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Frequency inputs (FREQ 1 to FREQ 5)
The Canalogger includes 5 frequency inputs protected against short circuits to ground, battery, 5 V and 15 V.

4 pins frequency input sensor

Description Characteristics

Sensor used

• Sensors with voltage output 
(all inputs, 0-15 V signal)

• Sensors with current output 
(inputs 1 to 4, 7-14 mA signal)

• Sensors with differential output 
(input 5 only)

Measured frequency range

From 0 to 8.5 KHz on each input.
The sum of the frequencies 
simultaneously should not exceed 
20KHz.

Components  JAEGER references
Female plug 4 pins 1 mm 530 801 006
Cable gland 4 pins 1 mm 769 907 006

Sensor Pin Function

Speed sensor / voltage or power signal

1 Voltage signal
2 Current signal
3 Ground
4 +15 V

Speed sensor / voltage or differential signal

1 Differential (+)
2 Differential  (-)
3 Ground
4 +15 V

Note:
• Freq 5 can be used like differential or voltage;
• Freq 1, Freq 2, Freq 3 and Freq 4 can be used like voltage or current.
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Digital inputs (DIG 1 to DIG 8)
The Canalogger includes 8 digital inputs with contact to ground or on +V batt.
These inputs are protected against short circuits to ground, battery, 5 V and 15 V.

3 pins digital input sensor

Description Characteristics
Max. sample frequency 350 Hz

Input • Switches with contact to ground
• Contact on + vbatt (>6V)

Components  JAEGER references
Female plug 3 pins 1 mm 530 232 006
Cable gland 3 pins 1 mm 769 907 006

Sensor Pin Function

Sensor with contact to ground
1 Signal
3 GND

Sensor with contact to battery (>6V) 2 Signal
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Analog inputs (ANA 1 to ANA 12)
The Canalogger includes 12 analog inputs protected against short circuits to ground, battery, 5 V and 15 V.

7 pins analog input sensor

Description Characteristics
Max. sample frequency 350 Hz

5, 10 and 50 V
0-20 mA et 4-20 mA

Supply 5 and 15 V

Components  JAEGER references
Female plug 7 pins 530 272 006
Cable gland 7 pins 1 mm 769 919 006

Sensor Pin Function

0-5 V sensor with +5 V or +15 V supply

1 +5 V
2 +15 V
6 Signal 0-5 V
7 Ground

0-10 V sensor with +15 V supply
2 +15 V
5 Signal 0-10 V
7 Ground

0-50 V signal
4 Signal 0-50 V
7 Ground

0-20 mA and 4-20 mA* sensors with +5 V or + 
15 V supply

1 +5 V
2 +15 V
3 Signal 0-20 mA
7 Ground

* Using 4-20 mA sensors is possible by configuring the 0-20 mA input and tuning 4 mA threshold for the «zero» 
of the sensor.



18/1/08 11

H
ar

dw
ar

e
So

ftw
ar

e

POCLAIN HYDRAULICS Data Logger

Temperature inputs (TEMP 1 to TEMP 8)
The Canalogger includes 8 temperature inputs protected against short circuits to ground, battery, 5 V and 15 V.

7 pins temperature input sensor

PT 100 cable mounting

Description Characteristics
Max. sample frequency 25 Hz

Sensor used
• Type «K» temperature sensors
• PT 100 sensors

(2, 3 and 4 wires mounting)

Components  JAEGER references
Female plug 7 pins 1 mm key 2 530 912 636
Cable gland 7 pins 1 mm 769 919 006
Temperature sensors K 1 mm sockets 
(for plug) 530 351 006

Sensor Pin Function

Cable for «K» temperature
5 Thermo (-) (Alumel)
6 Thermo (+) (Chromel)

Cable for PT 100 1 P
2 +
3 -
4 G

2 wires mounting 3 wires mounting 4 wires mounting

Simultaneous combinations Type K PT 100

Number of simultaneous combinations
0 to 4 0 to 4
0 0 to 8
0 to 8 0
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Supply (Power)

4 pins supply connector 

CAN/COM plug

7 pins CAN/COM plug

Components JAEGER references
Female plug 4 pins 1 mm 535 151 006
Cable gland 4 pins 1 mm 769 627 006

Pin Function

Supply cable
1 and 2 supply (+)
3 and 4 supply (-)

Components JAEGER references
Male plug 7 pins 1 mm 530 273 006
Cable gland 7 pins 1 mm 769 919 006

Sensor Pin Function

CAN connector
2 CAN_H
6 CAN_L
7 GND

Serial link connector to set time

1
RxD Pc 
(to pin 2 of the DB9 connector 
linked to the PC)

3
CTS Pc 
(to pin 8 of the DB9 connector 
linked to the PC)

4
RTS Pc 
(to pin 7 of the DB9 connector 
linked to the PC)

5
TxD Pc 
(to pin 3 of the DB9 connector 
linked to the PC)

7
GND
(to pin 5 of the DB9 connector 
linked to the PC)
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DIAG plug
• Use the SD PC cable to communicate with the PC via RS 232.
• Use the SD HHT LT cable to communicate with the hand held terminal.

Accuracy of acquisitions and recommendations concerning wiring

Accuracy table

Recommendations concerning wiring

In order to ensure the accuracy indicated above, it is necessary, for each sensor used, to connect the mass of the sensor directly
to the pin of mass of the corresponding connector. Any connection of the mass of the sensor directly with the mass of the frame
of the vehicle must also be avoided. These recommendations aim at removing any offset related to different potentials of mass 
between sensor and Canalogger.

Component identification

A : Model code:
e.g. SD CANALOGGER

B : Code (Part number):
e.g. A01753F

C : Serial number (Bath number):
e.g. 001

D : Number (Chronological number):
e.g. 001

E : Manufacturing country
F : Manufacturing plant

Kind of input Accuracy
Analog inputs +/-2% of full scale
Frequency inputs <1%
Temperature inputs (using thermocouple) +/-0.5°C
Temperature inputs (using PT 100) +/-0.1°C

A

B

C

D

E

F

SD CANALOGGER

001

A01753F

001
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CANALOGGER EXPLORER SOFTWARE
PC Canalogger Explorer software combined with Canalogger
Installed on a computer running a Windows OS and connected to a Canalogger via its serial port, the Canalogger Explorer software can be used 
to set up different inputs, to collect and save data (frequencies, temperatures, etc.)

The Canalogger Explorer software allows the user:
• to define and set up the inputs;

• to read in real time the inputs values;

• to record continuously or as soon as a particular event occurs (Trigger).

Canalogger set-up
The Canalogger is set up using the Canalogger Explorer software application or the hand held terminal.

Installation and initial use

Required equipment
Before proceeding to installation, ensure that you have the following items:

• PC type computer configured with:

- Processor : 166 MHz min.;
- Memory (RAM): 64 MB min.;
- Hard disk: free space 20 MB min.;
- Windows 98, 2000 or XP operating system;
- CD-ROM drive;
- Compact Flash card drive or PCMCIA;
- Colour monitor with minimum resolution of  800 x 600 points;
- RS 232 serial communication port;

• Installation CD-ROM for Canalogger Explorer software programs;

• Connection cable between the PC and the Canalogger (supplied).

Software installation
1 - Close all active programs and deactivate any antivirus that may be running on the PC. Only Windows must be running.

2 - Open the CD-ROM from Windows.

3 - Double-click on setup Canalogger Explorer™ to install the files required for the software and follow the on-screen instructions.
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Inputs set-up via the Canalogger Explorer software

 Launch the Canalogger Explorer application double-clicking on the  icon. The following screen is displayed:
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Analog inputs set-up
1 - Click on Analog inputs tab. The following screen is displayed:

2 - In Short Name field, enter the short name of the input (this name will appear on the hand held terminal).

3 - In Name field, enter the whole name of the input. If no name is seized in the field, the following message is displayed:
.

In the same way, the following message is displayed if the name you seized starts with a figure:
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4 -  To set up the input unit, click on the «Setup» icon . The following dialog box is displayed:

5 - Click on the value you want: bar, PSI, %, volt (or mA for the 0-20 mA input).

6 - Click on the type of input you want: 0-5 V, 0-10 V, 0-50 V or 0-20 mA (using 4-20 mA sensors is possible by configuring the 0-20 mA input 
and tuning a 4 mA threshold for the «zero» of the sensor).

7 - According to the unit and the type of input selected, various fields must be filled-up:

• The Calibration field corresponds to the resolution of the sensor used for measurement;

• The field located under the Calibration field corresponds to the set-up of the zero i.e. to the value according to the unit chosen for 

which the value of the selected sensor is null.

So, we have:

• If the bar unit has been selected, fill the Calibration field (unit: bar/volt or bar/mA) and the Volt to 0 bar or mA to 0 bar field;

• If the psi unit has been selected, fill the Calibration field (unit: psi/volt or psi/mA) and the Volt to 0 psi or mA to 0 psi field;

• If the % unit has been selected, fill the Calibration field (unit: %/volt or %/mA) and the Volt to 0 % or mA to 0 % field;

• If the Volt unit with 0-5V, 0-10V or 0-50V input has been selected, no field is to be filled;

• If the mA unit with 0-20mA input has been selected, no field is to be filled.

8 - Click on «Apply» to validate the settings.

Go to sensor 12
Next sensor

Copy the setup values to next 
sensor

Back to sensor 1

Previous sensor
Copy the setup values to 
previous sensor

Changeable sensor name
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The name of the input can be modified in the field of this screen. If no name is seized in the field, the following message is displayed:
.

In the same way, the following message is displayed if the name you seized starts with a figure:

9 - Then, various options are possible:

• Click on «OK» to go back to the Analog inputs tab.

• Display the previous sensor by clicking on the  icon or the next sensor by clicking on the  icon: then, resume procedure 

from step 5.

• Display sensor 1 by clicking on the  icon or sensor 12 by clicking on the  icon.

•  Copy the current setup values to previous sensor by clicking on the  icon or to next sensor(s) by clicking on the  icon.

10 - Once all the sensors have been set up, click on «Apply» to validate the settings then click on «OK» to go back to the Analog inputs tab.

When you copy settings, all the parameters are copied, THE 
CHANNEL NAME INCLUDED. Remember to rename the 
channels in the «Name» field of the «Analog inputs» tab.

To copy the setup values to next 
sensor(s), you can also click on 
this icon and make it slip on the 
next sensor icon(s).
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Frequency inputs set-up
1 - Click on Frequency inputs tab. The following screen is displayed:

2 - In Short Name field, enter the short name of the input (this name will appear on the hand held terminal).

3 - In Name field, enter the whole name of the input. If no name is seized in the field, the following message is displayed:

In the same way, the following message is displayed if the name you seized starts with a figure:



20 18/1/08

 Data Logger POCLAIN HYDRAULICS

4 -  To set up the units of the input, click on the «Setup» icon . The following dialog box is displayed:

5 - Click on the value you want: Hz, l/min, RPM, km/h or mph.

6 - According to the unit and the type of input selected, various fields must be filled:

• If l/min or RPM have been selected, fill the Resolution field;

• If km/h or mph have been selected, fill the Resolution and Circonference fields;

• If Hz has been selected, no field is to be filled.

Nota:

• When the l/min, RPM, km/h or mph units are selected, a message, specific to each unit, appears at the bottom of the dialog box:

Example of message if the selected unit is l/min:

Go to sensor 5
Next sensor

Copy the current setup values to 
next sensor

Back to sensor 1

Previous sensor

Copy the current setup values to 
previous sensor

Changeable sensor name

Message
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If an erroneous value is seized, this message appears in red:

7 - In this case, enter a correct value.

8 - Click on «Apply» to validate the settings.

The name of the input can be modified in the field of this screen. If no name is seized in the field, the following message is displayed:

In the same way, the following message is displayed if the name you seized starts with a figure:

Maximum resolution is 13Hz/(l/min)
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9 - Then, various options are possible:

• Click on «OK» to go back to the Frequency inputs tab.

• Display the previous sensor by clicking on the  icon or the next sensor by clicking on the  icon: then, resume procedure 

from step 5.

• Display sensor 1 by clicking on the  icon or sensor 5 by clicking on the  icon.

•   Copy the current setup values to previous sensor by clicking on the  icon or to next sensor(s) by clicking on the  icon.

10 - Once all the sensors have been set up, click on «Apply» to validate the settings then click on «OK» to go back to the Frequency inputs tab.

When you copy settings, all the parameters are copied, THE 
CHANNEL NAME INCLUDED. Remember to rename the 
channels in the «Name» field of the «Frequency inputs» tab.

To copy the setup values to next 
sensor(s), you can also click on 
this icon and make it slip on the 
next sensor icon(s).
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Temperature inputs set-up
1 - Click on Temperature inputs tab. The following screen is displayed:

2 - In Short Name field, enter the short name of the input (this name will appear on the hand held terminal).

3 - In Name field, enter the whole name of the input. If no name is seized in the field, the following message is displayed:

In the same way, the following message is displayed if the name you seized starts with a figure:

4 - In Setup column, click on the active buttons to select «Type K» or «PT 100» (set-up 4 by 4).

5 - In Unit column, click on the active button to select «C°» or «F°» (set-up for the 8 sensors).

Active buttons
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Digital inputs set-up
1 - Click on Digital inputs tab. The following screen is displayed:

2 - In Short Name field, enter the short name of the input (this name will appear on the hand held terminal).

3 - In Name field, enter the whole name of the input. If no name is seized in the field, the following message is displayed:

In the same way, the following message is displayed if the name you seized starts with a figure:

4 - In Type column, click on the active buttons to select «Switch» (contact to ground), or contact to the battery’s positive terminal (’’+12 V’’ or 
’’+24V’’ according to battery voltage).

Active buttons
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Triggers set-up
1 - Triggers are conditions for automatic data record. Click on the Triggers tab. The following screen is displayed:

2 - Click on  or on  to select the type of input.

Nota: the analog, frequency, temperature and digital inputs appear in the list as well as the Bus CAN Machine database signals (if used).

3 - Click on the input you want to apply triggers to.

4 - Then, various options are possible:

• Enter a value into the > Upper than field;

• Enter a value into the < Lower than field;

• Enter values into the <> Between field.

5 - Select a «Post-Trig» value in the scrolling menu. The «Post-Trig» value is the recording time after the detected value has become false.

6 - Select a link between triggers: AND or OR.

7 - Once these values have been chosen, click on the  active button to validate the condition: a program line is

displayed into the white rectangle. It is possible to eliminate a condition clicking on the  active button when the line to 

eliminate has been selected.

In case of error (value seized out of the sensor range), the following message is displayed. In this case, click on «OK» to close the 
message and check the entered values.

Selected input range
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7 - The  and  active buttons select the triggers in the list.

The maximum number of triggers is 7. In the event of going 
beyond, the following message is displayed: 

If several conditions with different Post-Trig are bound by 
AND, the Post-Trig selected will be that of the event which will 
disappear the first. 
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Recording options set-up
1 - Click on Recording options tab. The following screen is displayed:

Machine CAN Bus 

Proceed only if you use a CAN Bus.

1 - In the Machine CAN bus area, click on «Can-bus activated» box to display options.

2 - Tick the options and enter the values you want.

The CAN machine database contains the external signals to 
be recorded. Its extension is "dbc". 

Default Settings

Customize settings

Adjust the speed of the CAN Bus

Adjust the type of the identifiers of 
the CAN Bus messages (initial 
setting,11 bits)

Record all the messages or only 
those present in the data base

Data base of the CAN Bus Machine 
to record
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Record type

1 - Click on the «Pretrig» box to record what occured before the record starts. The pretrig duration depends on the collecting speed and the 
CAN-bus charge.

2 - Click on the «Circular memory» box so that the Canalogger writes current measurements by crushing the oldest records when the memory 
card is saturated.

General

This area covers the analog, frequency and digital inputs.

To define sample frequency and average, move the cursor on the line or enter the value you want. The final frequency is automatically calculated.

Temperatures

The set-up of the sample frequency for temperatures is generally lower than for the analog, frequency and digital ones.

To define sample frequency, move the cursor on the line or enter the value you want.

Sample frequency varies from 0 to 350 Hz (to 200 Hz in the 
event of request for histograms). 

Frequency is set up in mHz (25 000 mHz max.)

Number of
measurements / second

Number of points
used to do a record

Result of the sample frequency 
and average combination

Example of final frequency:

300 Hz = 300 measurements / second
Average on 100 points
Final frequency = 3 records / second
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Advanced settings
1 - Click on Advanced settings tab. The following screen is displayed:

2 - In Serial communication on area, select the serial port to be used or clik on «Find» to find one. The following dialog box is displayed:

3 - If the Canalogger is not connected to the PC, the following message is displayed:

4 - Click on «No» to abandon or on «Yes» to retry once you have checked the connections.

Serial port used

Capacity and
availability 
of the memory card

Button to update the 
Canalogger internal clock

Button to find the serial 
port the Canalogger is 
connected to
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Update Canalogger internal clock

1 - In Mode menu, tick the «Offline» submenu.

2 - In the Advanced settings tab, click on «Update Canalogger internal clock».

Imperatively use the clock update cable.

Button to update the 
Canalogger internal clock
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The following dialog box is displayed:

3 - Ensure that the memory card is not in the Canalogger and that the PC is properly set.

4 - Click on «OK».

5 - Click on «OK». The following message is displayed:

6 - Click on «OK» to go back to Tools tab.

If the Canalogger is «Online», the following message is dis-
played:

Click on «OK», select the «Offline» option and chek that the 
RS232 cable is connected to the CAN/COM connector before 
resuming procedure.

If the Canalogger is not connected or supplied, the following 
message is displayed:

Check connections.
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Histograms set-up

Introduction

The histograms are a set of long lasting measurements that permit to obtain a global sight of a machine or a system operation. Thus, instead of 
obtaining a value of each sensor for each sample period (a graph value = f(time)) as a result, this Canalogger Explorer functionality permits to 
obtain an histogram representing the time spent in each interval of values (a graph duration = f (interval of values)).

In order to describe the functionalities related to the histograms, we are going to present an example of a real case. 

Example:

The Canalogger is installed on a machine with Poclain Hydraulics hydraulic motors. We wish to know here the distribution in the time of certain 
parameters characterizing this machine such as: 

• The pressure HP_A (forward direction pump output pressure);

• The pressure HP_B (reverse direction pump output pressure);

• The charge pressure of the pump;

• The speed of the vehicle;

• The temperature HP (temperature of the hydraulic system);

• The outside temperature. 

The table below indicates for each state of the machine the histograms of the sensors we want to recover. 

Moreover, we want to know for each interval of pressure in forward direction the average speed of the vehicle.

Now it remains to characterize the various states of the machine, as follows: 

• If the digital input of the Canalogger named FG is 1, the machine is in forward direction;

• If the digital input of the Canalogger named RG is 1, the machine is in reverse direction;

• If the Temp_Ext input is lower than 5°C, the machine is cold;

• If the HP_A or HP_B input is higher than 350 bars, the machine is in overpressure (a virtual input will be used here). 

These various states of the machine will represent the families of histograms which must be declared.

Glossary:

• Histogram: group of 20 intervals. 

• Interval: value, expressed as a percentage, describing the time spent by an input (analog, temperature, frequency) between a minimum 

value and a maximum value (terminals of the interval). 

• Histograms families: set of histograms related to one or more update conditions. 

State of the machine 

Sensor name Input and unit Forward 
direction

Reverse 
direction When cold When 

overpressure

HP_A Analog (bar) X X X
HP_B Analog (bar) X X X
Charge Analog (bar) X X X X
Speed_vehicle Frequency (km/h) X X X
Temp_Ext Temperature (°C) X X X
Temp_HP Temperature (°C) X X X
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Histograms families

1 - Clik on the Histograms tab. The following screen is displayed:

2 - For our example, four families, renamed in the Histograms families field, must be declared:

• Click on Family 1 and rename it as Forw_dir in the Name field;

• Click on Family 2 and rename it as Rev_dir in the Name field;

• Click on Family 3 and rename it as When_Cold in the Name field;

• Click on Family 4 and rename it as Overpressure in the Name field.

For each family, we add the inputs defined in the table of the previous page. Now, the virtual and average inputs must be defined as 
follows:

• Double-click on the input you want in the left-hand column: this one is automatically added under the family to be set up. Double-

click on the added input to remove it. 

Rename a family

None or 20 intervals 
per histogram

Update conditions area

Function and average inputs 
area

Add/delete
an input in a family

Change first and last 
terminal: allows to 
concentrate the histogram 
on a zone of interest 
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Click on the input you want in the left-hand column and on the Add button: the input is automatically added under the family to be set up. Double-
click on the added input to remove it. 

So, we have:

The "Activated" box is automatically ticked since an input is 
added in the family. Tick this box off to deactivate a family: all 
the inputs are automatically deleted from the family. 
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Virtual and average channels

In addition to the 25 traditional inputs (12 analog inputs, 8 temperature inputs and 5 frequency inputs), 4 virtual channels (VIRT) are also 
available. They permit to make various operations (product, sum, difference, min, max) between 2 inputs. A coefficient a and an offset b can 
also be defined. 

VirtualChannel1 (VIRT_1) = a* function (ChannelA, ChannelB) + b

It is also necessary to define the first and the last terminal. These virtual channels are used to measure a power (for example, product 
between a flow and a pressure). 

Four average channels (AVG) are also available. For each one, the user selects 2 channels. Thus, he defines which channel is averaged 
according to which other channel. For example, if the user selects a frequency input (for a speed) and an analog input (for a pressure), the 
average speed for each interval of pressure will be calculated by Canalogger Explorer. The average channels will be stored like an 
histogram. This histogram will be balanced by averages and not by the time spent in each interval. So, it is not necessary to define first and 
last terminal for these channels. 

1 - In the Function and average inputs area, click on the input to be set up or on .

The following dialog box is displayed:

For our example, we declare a virtual channel that permit to indicate the max between the analog inputs HP_A and HP_B. We also declare 
an average channel of speed of vehicle for each interval of pressure HP_A:

• VIRT_1 = 1 * max (HP_A, HP_B) + 0

• AVG_1 = average of (Speed_Vehicle) for each interval of (HP_A)

Then, we add the virtual channel 1 to the Overpressure family and the average channel 1 to the Front_Gear family. When all the channels 
have been added to each family, it is necessary to indicate the update condition for each of them. 

When a virtual or average channel is added to a family, it is 
also necessary to add the inputs that compose that input 
(example for the VIRT_1 channel, it is necessary to add the 
inputs HP_A and HP_B to the Overpressure family).

Select a
virtual channel

Coefficient a Operands

Select an
average channel

Operation

Channel to be averaged

Offset b

Interval channel
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Update conditions

The update of the histograms composing a family can be conditioned on the state of one or several digital inputs.
Moreover, a condition can be added on one of the channel (higher or lower than a threshold). 

2 - In the Update conditions area, for each signal, enter:

• 0: the family histograms are updated if the digital input = 0;

• 1: the family histograms are updated if the digital input = 1;

• x: the family histograms are updated whatever the value of the digital input. 

For our example, the update conditions of each family are as follows: 

Family Update conditions

Forw_Dir Digital input FD = 1

Reverse_Dir Digital input RD = 1

When_Cold All digital inputs = X AND Temp_Ext < 5°C

Overpressure All digital inputs = X AND VIRT_1 > 350

These names correspond to the 
short names of the digital inputs

Value

Scrolling menu
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First and last intervals

It is also possible to dimension the intervals in the First and last intervals area (it is not necessary to define terminals for the average 
inputs since those are already defined in the input set-up).

Intervals

Click on None (histograms deactivated) to go up to a 350 Hz sample frequency. If not, click on 20 (activated histograms). The sample 
frequency will then be limited to 200 Hz. 

The histograms set-up is done and will be transmitted to 
Canalogger Explorer as one of the configuration properties 
according to the procedure defined in chapter “Send settings 
to Canalogger”, page 40.
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Tools
1 - Click on Tools tab. The following screen is displayed:

Icon Description
Memory card icon grayed Memory card out of PC

Memory card icon active The memory card is in and recognized by the PC
(the card is automatically detected by the software) 

Cable icon grayed The Canalogger is not connected to the PC by the serial cable or is not powered

Cable icon active
The Canalogger is connected to the PC by the serial cable
To determine the serial port to which the Canalogger is connected, click on the «Find» button in the 
Advanced settings tab.

On line/Off line button If the Canalogger is connected to the PC with the serial cable, this button becomes active.
We can see in real time the values of the Canalogger inputs and launch a manual recording. 

On line/Off line

Recording

Record on/off
On/Off

Error
Memory capacity

Memory card in/out

Canalogger
connected to PC

Show errors
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Manual data recording

1 - Put the compact flash card into the Canalogger.

2 - In Mode area, click on  button to be online:
• The «Record command» button becomes active;

• The green led lights up;

• The red led flashes (if error).

3 - Click on  button to start recording: the blue led lights up.

4 - Click on  button again to stop recording: the blue led turns off.

5 - To read the recorded data, put the compact flash card into the PC.

6 - Follow the procedure “Read card data”, page 44.
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Send settings to Canalogger

1 - Put the compact flash card into the PC and connect the Canalogger to the PC.

2 - Click on «Send settings to Canalogger». The following dialog box is displayed:

3 - Click on «Validate» to send the settings or on «Cancel» to go back to the Tools tab.

4 - Once action has been validated, the following dialog box is displayed:

5 - Select destination directory for settings file, enter file name and click on «Save». A message is displayed:

6 - Click on «No» to cancel and go back to the Tools tab or «Yes» to go on. In that case, transfer is launched:
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Read settings data from Canalogger

This function allows updating inputs tabs with short names and triggers but not the bus CAN machine database (if used). To obtain whole 
names, use the “Open file...”, page 53 function.

1 - Put the compact flash card into the PC and connect the Canalogger to the PC.

2 - Click on «Read settings from Canalogger». The Canalogger Explorer gets the settings from the Canalogger, the following dialog box is 
displayed:

3 - Select destination directory for settings file, enter file name and click on «Save». Transfer is launched:
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4 - When the reading of the records of the memory card is finished, it is possible to number and date the records: 

• In the field «Number records from», enter the number from which to begin the numbering of the records. 

• Tick the box «Dating records» so that the name of the file which will be recorded comprises the date of record. 

If a bus CAN machine is detected, the following message is 
displayed. Click on «OK» and specify the CAN machine 
database used.
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5 - Click on «Save». In the dialog box, enter the name of the file and click on «Save»: the date of record is automatically added in the name 
of the file. 

6 - Then, the file is converted to the asc format. 

7 - When the conversion is finished, it is possible to erase the records of the memory card: 

• Tick the box and click on «OK» to erase the records.

• Click on «No» to keep them.

To read the records, refer at step 7 of chapter «Read card 
data».
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Read card data

1 - Put the compact flash card into the PC

2 - In the Tools tab, click on «Read card data». The following dialog box is displayed:

3 - When the reading of the records of the memory card is finished, it is possible to number and date the records: 

• In the field «Number records from», enter the number from which to begin the numbering of the records. 

• Tick the box «Dating records» so that the name of the file which will be recorded comprises the date of record. 
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4 - Click on «Save». In the dialog box, enter the name of the file and click on «Save»: the date of record is automatically added in the name 
of the file. 

5 - Then, the file is converted to the asc format. 

6 - When the conversion is finished, it is possible to erase the records of the memory card: 

• Tick the box and click on «OK» to erase the records.

• Click on «No» to keep them.
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7 - Open software Canalogger Viewer by clicking on its icon:

The following screen is displayed and it is automatically proposed to open an ASC file:

Navigate in folders tree and select the ASC file you want to read.

Note: ASC files are containing data for graphics. This data is not usable without a DBC file which describes the structure of this data. Each 
time it is possible, Canalogger Viewer automatically selects the appropriate DBC file in same folder than selected ASC file. If Canalogger 
Viewer does not find the appropriate DBC file, it will ask you to select it:

8 - Canalogger Viewer reads the ASC file and orders the signals on the right side to have used chanels on top of the list:

Unused channels (with default names set by Canalogger Explorer like ’’ANA_1’’) are put at the bottom of the list.

Each channel block contains the name of the channel, the current value with its unit, color block and two check boxes:

• When clicking on color block, you can modify the color of associated curve. 

• Right check box--------allows you to display or not the curve.

• Left check box -------allows you to display or not the scale of the curve. This is useful when several channels are using the same 

scale. You can display only one scale for several channels.

You can modify the channel order by clicking on a channel and moving it to desired position.
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Double-click on channel allows to display and modify the channel properties.

It is possible to change curve color, line width (1, 2 or 3 pixels) and to define scale range for this channel: Automatic, manual (with mini. 
and max. input) or predefined (0/5, 0/50, 0/100 or 0/500).

9 - If data has been recorded from machine CAN bus, the button ’’CAN’’ in tool bar is enabled. When clicking on CAN button, a window 
is displayed, with on left part the CAN message(s), bellow information about selected CAN signal, and on the right, the list of all available 
channels:

To get the curve from a CAN signal, select on the left part a CAN message. If needed, clic on small ’’+’’ at the beginning of the line, then 
select the desired CAN signal.
Each time you select a CAN signal, a preview of the curve is displayed below. You can also click on Delail tab to get information about 
selected CAN signal.
Select on the right side the channel you want to use to view the curve from CAN signal, then click on ’’Transfer’’. Main window now 
displays the CAN signal’s curve in selected channel.

10 - Each time you close a graphic (when closing Canalogger Viewer or opening a new ASC file), Canalogger Viewer proposes you to 
save the graphic configuration for other ASC files in same folder. This will allow you to find back the same configuration (colors, 
channels order in the list, curves position in graphic) when opening another ASC file. The zoom is also saved with each ASC file,
allowing the software to restore the previous zoom each time you open back an ASC file.

11 - You can print the graphic as you see it on screen (color, zoom...). Just select menu File / Print.

12 - You can copy the graphic to the clipboard using menu Edit / Copy. You can paste the graphic in word, Excel...

13 - You can choose the default colors used for next graphics using the menu Option / Default colors:

All of the 33 channels of Canalogger is shown as a color block. You can modify the default color of a channel by clicking on its color 
block and selecting the desired color.
Selected colors will be applied to future graphics. After validating, software proposes you to apply these colors to current graphic.
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14 - You can choose the default range for each unit using the function Options/Default ranges. Defined range will be applied to future 
graphics. You can also directly apply a range by pressing corresponding " Apply " button. After validating, software proposes you to apply all 
the defined ranges to current graphic.

15 - You can choose the language of Canalogger Viewer by selecting the menu ’’Option/Language’’. This choice will be saved for next session 
of Canalogger Viewer.

16 - Tool bar proposes you several options. Here are these options:

With the Hand tool you can browse in the curve. Click on the curve and make it slip horizontally and/or vertically. You 
can also browse in the curve by using the vertical and horizontal scrowlers (it is not necessary to select the hand tool to 
use the scrowlers).

The Cursor tool displays on the curve a cross (a cursor) which follows the mouse. When the mouse moves, the cursor 
displays the value you pass on. While clicking then moving the mouse, a second cursor is displayed with its values. The 
difference between these two cursors is also displayed. The cursor takes the color of the nearest curve.

The Magnet tool (selected by default) enables the Cursor tool to cling to the nearest curve. When the Magnet tool is 
selected, you are sure that the displayed value is the curve's one. When the cursor is positioned on a real point 
(corresponding with a sample), the cursor highlights this point, enabling you to make the difference with an interpolated 
point (between two sampled points). When the Magnet tool is not selected, the cursor moves freely under the mouse.

The Zoom tool allows to zoom on the curve. Select this tool, then click on the curve and move the mouse while 
maintaining the button pressed to define the new displaying window. As soon as you release the button of the mouse, 
the curve is displayed again according to the new defined window.

The Sample tool displays a small square on each sampled point. This function is useful to differentiate the sampled 
points from the interpolated points (between two sampled points).

The Position tool displays, on the left-hand part, a vertical segment for each curve displayed. Click on the tip of one of 
these segments, and then move it, to define the height of the curve concerned. Click on the middle of one of these 
segments, and then move it, to define the vertical position of the curve concerned. If Control key is pressed while moving 
a curve, all curves with same unit are following the moved curve. This function is useful to organize the position of the 
curves and thus facilitate their interpretation.

The Time scale tool allows to select the horizontal time scale.
Possible choices are: no scale, automatic scale, every second, every 2, 5 or 10 seconds.

The Background color tool allows to choose the background color of the curves. This function allows to make curves 
more readable according to the lighting conditions (outside, in particular).

The Scrollers at the right and at the bottom allows to browse in the curve. It is possible to move in the curve by clicking 
on the middle of a scroller, or to modify only one tip of the scroller. Then, you obtain a zoom effect. Double-click on a 
scroller to give it its maxima values. This ensures that all the vertical or horizontal range is displayed.

Undo tool allows to cancel latest zoom or scrolled change, and consequently to restore previous view.
Latest 50 changes on zoom and scrollers are saved.
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Erase card data

1 - Put the compact flash card into the PC.

2 - Click on «Erase card data». The following message is diplayed:

3 - Tick the box «Yes! I want to erase data on card!» and click on «OK». The following message is displayed:

4 - Click on «OK» to go back to the Tools tab.
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Read histograms from Canalogger

1 - Connect the Canalogger to the PC.

2 - In the Tools tab, click on «Read histograms from Canalogger». The following dialog box is displayed. Select a directory to put the histograms
into.

To read the histograms from the Canalogger, it is necessary 
to open the configuration containing the settings of the 
histograms you want to read.
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3 - Open the Excel file:
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Show errors

In the Tools tab, click on «Show errors». The following screen is displayed:
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Canalogger Explorer toolbar
This is the Canalogger Explorer toolbar:

«File» menu

The File menu consists of 4 sub-menus:

• Exit

When you quit Canalogger Explorer software, the following dialog box is displayed:

«Mode» menu

The Mode menu consists of 2 sub-menus:

Function Description

Open file...

Open a saved file of settings:
1 - Click on «File» and «Open file...».
2 - In the displayed dialog box, click on the file of settings you want to open and click 
on «Open».

Save file Save the current settings.

Save file as...

Save the current settings:
1 - Click on «File» and «Save file as...».
2 - In the displayed dialog box, select the destination directory for the settings file, 
enter the file name and click on «Save».

Exit See below.

Function Description

Save This option is automatically selected to avoid forgetting to record. It is possible to 
tick this option off.

Send To send the settings to the Canalogger (see “Send settings to Canalogger”, 
page 40).

Exit To quit Canalogger Explorer software.
Validate To validate the selected options.
Cancel To close dialog box and go back to the interface.

Function Description

On line
If the Canalogger is connected to the PC with the serial cable, the «On line» mode 
permits to see in real time the values of the Canalogger inputs and to start a manual 
record. 

Off line Select this option when the Canalogger is not connected to the PC.
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«Functions» menu

The Functions menu consists of 5 sub-menus that correspond to the functions of the Tools tab.

«Language» menu

This menu allows selecting the interface language.

«?» menu

The «?» menu consists of 1 sub-menu called «About...».

1 - Click on «About...»: the following dialog box is displayed, that indicates the Canalogger Explorer software reference.

Function Description
Send settings to Canalogger  See “Send settings to Canalogger”, page 40.
Read settings from Canalogger  See “Read settings data from Canalogger”, page 41.
Erase card data  See “Erase card data”, page 49.
Read card data  See “Read card data”, page 44.
Read histograms from Canalogger  See “Read histograms from Canalogger”, page 50.

Function Description
English Select English.
Français Select French.
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2 - Click on «OK» to close the dialog box and go back to the interface or click on «Sys info...» to obtain further information: the following 
screen is displayed.
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Set-up with hand held terminal
The hand held terminal is used only to modify the settings directly in the Canalogger. There is no way of saving a configuration file. 

Connect the Canalogger to the hand held terminal with the CABLE SD HHT LT cable.

User interface

• Moving in the 

• Go from sub-

• Shortcut 

• Select a 

menu or a sub-menu

• Validate a 

parameter en-tered by 

the user
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Navigation principles

Main and function menus tree structure

MAIN MENU 1 SUBMENU 1.A

SUBMENU 1.B

SUBMENU 1.C

SUBMENU 2.AMAIN MENU 2

ENTER

ESC

ESC

ENTER

+ -

+ -

+ -

Analog input

Display of the Canalogger electric input/output values

Frequency input

Temperature input

Switch input

Internal values

Errors Display error code + designation

Record control State of the recording function

Setup Analog Analog inputs set-up

Setup Frequency Frequency inputs set-up

Setup Temperature Temperature inputs set-up

Setup DIG Digital inputs set-up

Setup Sample Sample frequency and average set-up

RestoreFactorySetting Restore default parameters

Histograms Activate/deactivate histograms

Software Information
Information provided:
P/N:  software part number
Date: software creation date
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Formulation of menus and sub-menus
Main Menu

Extract of sub-menu Meaning of sub-menu

Analog Input  Display of the analog inputs values in %, bar, psi or volt

ANA 1 psi = 0000.73
ANA 2 bar = 0003.09
ANA 3 bar = 0000.73

Analog inputs are numbered from 1 to 12

Frequency Input Display of the frequency inputs in Hz, l/min, RPM, km/h or mph

FREQ 1 km/h = 0000.73
FREQ 2 l/min = 0003.09
FREQ 3 l/min = 0000.73

Frequency inputs are numbered from 1 to 5

Temperature Input Display of the temperature inputs valued in C° or F°

TEMP 1 °C = 0000.73
TEMP 2 °C = 0003.09
TEMP 3 °F = 0000.73

Temperature inputs are numbered from 1 to 8

Switch Input  Display of the digital inputs (open or closed)

DIG 1 = Open
DIG 2 = Open
DIG 3 = Open

The digital inputs are numbered from 1 to 8

Internal Values Display of the analog, frequency and digital inputs raw values as well as the Canalogger supply voltage 
at + 5V and 15V

ANA1 = 0.00
ANA2 = 0.00
ANA3 = 0.00
ANA4 = 0.03

Example of display of the analog inputs raw values

Errors Display error code + designation

Error 010
Sensor 15V supply If error, display of the corresponding error code

Record control State of the recording function

Rec Cmd = StdBy

REC STATUS = Off

Free Mem (%) = 100.0

Rw allowed = No

Total Mem (Mo) = 000.0

Standby =Stop recording request
REC =Recording request

Off = Canalogger does not record
On = Canalogger records

Memory space still available on the card

Yes = circular memory
No = linear memory

Memory card capacity

Setup Analog Analog inputs set-up

ANA 1 type = 0-5V
Unit = %
%/V = 0150.0
V @ 0 % = 0000.0

Kind of sensor
Unit
Calibration
0 set-up

Setup Frequency Frequency inputs set-up

Freq 1 unit = km/h
Pulse/Rev = 060
Circonf (cm) = 100

Kind of sensor
Unit
Circumference set-up

Setup Temperature Temperature inputs set-up

TEMP 1/2/3/4 = Type K
TEMP 5/6/7/8 = PT100
Unit = °C

Kind of sensor inputs 1 to 4
Kind of sensor inputs 5 to 8
Unit
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Setup Sample  Sample frequency and average set-up

Analog/Digital/Freq
Sample HZ =200
Average Point =0001
Rec Speed Hz = 200.00
Temperature
Sample Hz =00.05

Sample frequency for the ANA, FREQ and DIG inputs
Number of average points
Final frequency calculated according to the 2 values above
Sample frequency for the TEMP inputs

RestoreFactortSeting Restore default perametres

To Restore Factory
Settings, type 7851
and press [enter]
Value = 0000

Restaure Canalogger default parametres(all inputs set-up, 
sample frequencies, etc.)

Histograms Activate/Deactivate histograms

Histograms
Time (h) =0010.01
Histo update = Enable
Reset
Family 1 = Off
Family 2 = Off
...

Histograms global duration

Activation/Deactivation of histograms update
Zero the histograms values but not their configuration
State of the families update

Software Information

P/N : 790 054 038
Date : 20.12.2005

Information provided :

P/N : software part number
Date : software creation date
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Error codes

Codes Description

1 Battery overload

2 Battery underload

3 15V SD too low, internal problem

4 5V SD too low, internal problem

5 Too many set-up histograms, reduce the number of histograms 

10 15V sensors too low

11 5V sensors too low

16 Error of a parameter checksum

17 Error of a parameter min/max

18 Error E2prom

30 Error temperature module #1, 2, 3 et 4: no communication

31 Error temperature module #5, 6, 7 et 8: no communication

32 No communication with the recorder: memory card out

33 90% of the memory card capacity are used 

34 100% of the memory card capacity are used
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